CCA- Fundamentals of IT & Programming

Assignment - 101

Q1. What are the four fundament parts of computer? Explain it with the help of diagram.

Ans.

Central Processing unit

Arithmetric/logic

. o

C
>

A

The four fundamental parts of computer are: C :
1.Input Devices: Computer systems use ma@i es for input purpose. Input devices include the
a

mouse, input pen touch screen, micropth rdless of the type of device used, all are
components for interpretation and co jcation between people and computer systems.

2. Central Processing Unit (CPU): I@ brain of the computer without this unit computer unable to

process. 2 'b
3. Output device: Output@ is used to show the result of the instructions. Example Monitor,
Printer, Headphon C.

4. Memory unit: 4 mémory unit is the collection of storage units or device together.
®

The memn%nytores the binary information in the form of bits.

Q2. Discu out the classification of computer based on size and capacity.

Super computers: They have thousands of process, Because of their extraordinary speed,
accuracy and processing power, supercomputers are well suited for solving highly complex
problems and huge amount of calculations.

E.g. JAGUAR, ROADRUNNER etc.

V4
Q;%d on size and capacity, computers are classified as

2) Mainframe computers: They are very large often filling an entire room and process thousands of
millions of instructions per second. They are capable of supporting hundreds to thousands of users
simultaneously. Functions performed by mainframes include flight scheduling, reservations and
ticketing for an airline etc.




3) minicomputers: They are much smaller than mainframes. They are typically larger, more powerful
and more expensive than desktop computers. Users connect to the server through a network by
using desktop computers.

e.g. apple | pod, CDC 160A.

4) Microcomputers: They are the most frequently used type of computers. It is also known as
personal computers.

e.g. Desktop computer, laptop.

Q3. What is the meaning of computer generation? How many computer generations are defin@

What technologies were/are used? @

Ans. Generation in computer terminology is a change in technology of a computer whi e being
used. There are four computer generation such as 1% generation, 2" generation, r% ration and
4t generation.

In the first computer generation system, vaccum tubes are used. \0%

Transistors are used in the Second generation. Q

Integrated circuit technology were used in the third generatian. %‘

In the fourth generation microprocessors are used. %

Q3. What is the meaning of computer generation? H ny computer generations are defined?

What technologies were/are used?

Ans. Generation in computer terminology is \e in technology of a computer which were being
used. There are four computer generatior@ 1%t generation, 2" generation, 3" generation and

4t generation.

In the first computer generation s vaccum tubes are used.
Transistors are used in the S %eneration.

Integrated circuit techn ere used in the third generation.

In the fourth geneh%
®

Q4. Different between volatile and non-volantile memories.

croprocessors are used.

Ans. Vdlati emory Non-Volatile memory
Vt iS a computer storage that 1. It is a type of computer
()Q) Only maintains its data while memory that has the capability
The device is powered. to hold saved data even if the power is turned
2 . E.g. RAM off.
3. Primary memory has limited 2. E.g. ROM, hard disk, floppy disk ,etc

storage Capacity and is

volatile 3.Secondary memory provides permanment storage
of data and in bulk quantity.




Q5. Distinguish among system software, application software and open software on the basis of
their features.

Ans. System software: Its is a type of software that is designed to run a computer’s hardware and
application programs. Software like operating systems, compilers, editors and drives etc. come
under this category. A computer cannot function without the presence of system software.

Q6. a) Create a file in MS-Word to insert a paragraph about yourself and save it with film name

“yourself”. Describe all step involved in it.

Ans. “Yourself” My name is Kongkham Malemnganba Singh. | am 20 years old. | love in pIaw’nQ%
Footballs. | am a student of Arts stream at IMPHAL COLLEGE, IMPHAL,MANIPUR. Currently | \
learning computer CCA course at RGI TRAINING INSTITUTION. ®

The steps involved are; ,2&

> We click the Microsoft office button. \

» We select new. The new documents dialog box appears. Q

» We select blank document under the blank and recent sectio "Q highlighted by
default.

We click create. A new blank documents appear in the v\%ﬂn ow.
To save the document, We click again the Microsoft®ffic tton.

We select save as == word document. The sﬁl log box appears.
do

We select the location where we want to save t ment using the drop down menu.
We enter the file “yourself” for the documento

We click the save button. \c_)

b) Write steps regarding followings.

» To change the font style %Q

» To change the font size
» To change the font colou
> To highlight (in yello e that reads “need to get IMS’s address”.

VVVYVYVYYVYYVY

Ans. Steps to change the le:

1. We select @Ne want to modify.
he

2. Leftclickd op-down arrow next to the font style box on the home tab. The font style
drop- nmenu appears.

3. vé cursor over the various font styles. A live preview of the font will appear in the
d ent.

?ée click the style we want to use. The font style will change in the document.
O

1. We select the text we want to modify.

2. Left click the drop-down arrow next to the font size box on the home tab. The font size
drop-down menu appears.

3. We move cursor over the various font sizes. A live preview of the font size will appear on
the document.

4. 4. Left click the font size we want to use. The font size will change in the document.

change the font size:

Steps to change the font colour:




1. We select the text we want to modify.

2. Left click the drop-down arrows next to the font colour box on the home tab. The font
colour menu appears.

3. We move cursors on various font colours. A live preview of the colour will appear in the
document.

4. Left click the font colour we want used. The font colour will change in the document.

Steps to highlight the line:

1. We select the line that reads “needs to get IMS’s address” Q%
R

2. We click the highlight command and select yellow colour in the font group on the hom.

Q7. Create a file in MS- Word for the following document and save it with file name ‘ms-
Describe all steps involved in it. &

MS-Word K’b

MS-Word is a widely used commercial word processor developed by Mi@%

Ms-Word is application software, Which is capable of Q\
e C(Creating, %_

e Editing, &

e Saving, \

e Printing any type of document, x

MS — Word is a widely used commerci@rocessor developed by Microsoft.

MS-Word is application software, wh@s capable of

e Creating %

e Editing ®

e Saving &

o Printir@ pe of document

The steps involved%?
1. kthe icrosoft office button.

We plic
2. e new. The new document dialog box appears.
3. lect blank document under the blank and recent section. If will be highlighted by

» default.
YN We click create. A new blank document appears in the word window.
Q) . We create the give documents from the question.
() 6. We select the text “MS-Word” to change the font size by clicking on the font size box on

the home tab.

7. We select the text “MS-Word” to change the font colour into red by clicking on the font
colour menu.

8. We select the text word processor and underline it by clicking underline command in the
font group the home tab.

9. We select the text “MS-Word” to change the font style into italic by clicking italic
command.

Ans. MS-Word




10. We select the text we want to format as a list and click on the bullets command on the
home tab.

11. We change the font colour of the text “creating” and “saving” into blue and red resp. By
clicking on the font colour command, again we select the text “and” and click on
strikethrough command.

12. We select the text “printing any type of document” and change the font style into bold by
clicking on the font style command.

13. We save the file name as “ ms-word” by clicking the Microsoft office button and select sav
as

14. We select the location where we want to save the document using drop-down mend Q

15. We click the save button. @
Q8. Create a file in MS-Word for the following document and save it with file name ‘equation’.

Describe all steps involved in it. (b

Equations:
Xa+y,=30
22+q*=50 Q
ar+b®=xa+y; &%—
Ans. Equations &\
O

X2 + Ys =30

e D
o)

The steps are:

1. We create the given doc s in MS-Word
2. We select the text w %& want to format and click on the subscript and superscript

command on the b
3. We save the fil as “equation” by clicking the Microsoft office button and select save
as

4. We select theNocation where we want to save the document using the drop down menu
5. Waexglickthé save button.

Q9. Cre% in MS-Word that convert existing highlight text to table as show below and save it
‘text to table ‘. Describe all steps involved in it.

as § e na
QS} ct the text you to convert.
() Select the insert tab.

Click on table command. A dialog box appears.
Click on convert text to table, a new dialog box appears here set number of columns.

Click on OK Finally Selected text convert in a table




Select the text convert you want to. Select the Insert tab.

Click on table command. A dialog box appears. Click on convert text to table, a new dialog box
appears.

Here set columns. Click on OK Finally Selected text convert in atable

Ans. To convert existing text to table:

We select the existing highlight text that we want to convert.

We select the insert tab

We click the table command

We select convert text to table form the menu. A dialog box appears
We click ok. Them the text appears in a table.

ok wN e

&
,§

Q10. Create a file in MS-Word to insert a table in the document. Describe all %ﬁnvolved init.

Ans. Q\
-

P\
\J

X0

The steps are: Q
1. We place our insertion g‘fthe document where we want our table to appear
2. We select the inser
3. We click the tabl %ﬂand
4. We dragour ver the diagram square to select the numbers of columns and rows
inthet b\m
5. Left cl% ouse and the table appears in the document.
6. e enter the text into the table.
®

Qill. Crea%o wing worksheet in MS-Excel and save it with name ‘book1’.

R})%b Name Marks
@ 1 nl 60
< ) 2 n2 70

3 n3 80
4 n4 90
5 n5 40
6 né 50
7 n7 77
8 n8 44
9 n9 88

10 n10 55




Ans.

Sum 654
average 65.5
Minimum maximum a0

question no 10.

Q12. Calculate the following things of a range (c2:c11) of data in the worksheet created in Q%

The sum of the marks using AutoSum in range of cells (c2:c11)
Average of the marks in range of cells (c2:c11)

Highest marks in range of cells (c2:c11)

Minimum marks in a range of cells (c2:c11)

1 nl 60 \
2 n2 70 Q
3 n3 80 %_
4 n4 90 ,\
5 ns 40 \
6 neé 50 \
7 n7 77 0
8 ng 44 \C-)
9 no 88 fb
10 n 10 55 v
Sum 6540

Average 65.5
Maximum 90

U’
Mini

Q13.a) Descn% s steps involved in the following
. rfiodi

column width of a worksheet
|fy the row height of a worksheet

@ delete rows and columns of a worksheet
’

Cr

Anv
() Select s column or a range of columns.

Select a Home tab and in the cells group, select format.
Click on column width and the width for column.
Select Ok.
To modify the row height of a worksheet.
Select a row or a range of rows.
Select a Home tab and in the cells group, select format.
Click on Row height and Type the height for row.
Select OK

N

&
>
RollNo. | Name | Marks Q%




- To delete rows and columns of a worksheet.
l. Select the cell you want to delete within the column or row.
II.  Select Home tab. And in cell group click on Delete Sheet Column or Row.
OR
i. Select the desire row or column.

Q13 b) Describe the following terms in the worksheet

- Absolute reference and relative reference in formula.
- Cell address. Q%

Ans. &\
- Absolute Reference:

An absolute reference in Excel means there is a fixed point of reference appli cellora
formula. This is so the return value will always stay the same no matter \I\Q ecell or
formula moves to — within the same sheet or across different sheet.

This refers to a fixed point of reference is a constant, and,gvolvés the use of dollar sign € in
the formula (i.e, everyone is to receive the same bow # 50 the amount €1500 is

constant in this situation). \
- Relative Reference : \c')

It is the default cell reference in Ex X\I' simply the combination of column name and row
number without any dollar € sign. n you copy the formula from one cell to another the
Q’ding on the relative position of column and row. C1, D2,

relative cell address change
E4, etc. are example o% ive cell references. Relative references are used when we want
to perform a similar on on multiple cells and the formula must change according to
the relative addr@ lumn and row.

This refers@tive point of reference, is constantly change and dollar sign (€) is absent
in the forgmula(i.e., When each unit price and quantity are difference variable, there’s no

cotwthe calculation).

well Address:
Q} A cell address is a combination of column letter and a row number that identifies a cell on a
() worksheet.
For example, Al refers to the cell at the intersection of column A and row 1; B2 refers to the
second cell in the column B, and so on.
When used in formula, cell references help Excel find the values the formula should
calculate. For instance,
To pull the value of Al to another cell, you use this simple formula:
=Al
To add up the value in cells A1 and A2, you use this one:




=A1+A2
Q14.a) What tools are available to customize our PowerPoint presention are:
Ans.
Tools available to customize our Power Point presentation are:
Perspector
Pivot viewer
Autodesk 3DS Max . %
VisualBee Power Pointg Add-in \Q
SmartArt

Animiations and Transition
Wordle ’b

CA coo K
. Oomfo %
j. Clip Champ Q
b) Write the steps for the following action for the creation of power%resentation

- Open a Blank presentation &%ﬂ

- Save the presentation as Labl.pptx

- Add aTitle to the first slide; the name of your colle \
- Type your first name and last name in the Sd\ﬁs&ecnon

- Add a New Slide which has a Title and Co rb

Ans. Q,Q

- Toopen blank presentatl
i Open Poweriéo sentatlon using ‘Run’ command ( window key + R)

S® 0 Qo0 T W

ii. Select the * esentation’. It is opened.
- Savethe prese n Labl.pptx;
I.  Select n tab bar.
II.  Click on*Save As option.
Il. C ?)r;document/Desktop as your choice.
IV. % e name ‘Lsb1.pptx’.
VN k the ‘Save’ button.
Adda Title to the first slide; the name of your college.
VP Left click on the ‘Click to add title’ section on the first slide.
Q} IIl.  Type the name of your college.
() - Type your first name and last name in the subtitle section:
l. Left click on the ‘Click to add Subtitle” section.
Il.  Type your first name and last name.
- Add a new slide which has a Title and content.
l. Select the Home tab.
Il Click on the dropdown button of the ‘New Slide‘ on toolbar.
lll.  Select the side having ‘Title and Content’. It is a added.




10

Q15. Write steps for creation of a set of PowerPoint slide that demonstrates your skill to use the
tools of PowerPoint. It should include the following things

Titles slide & bullet list
Inserting Excel Sheet
Clip art and text

Slide show effects

YV VYV

. Q%
> Title slide and bullet list: ®\
I.  Open PowerPoint presentation. &

Il. Select the Home tab.
lll.  Click at the dropdown button on ‘New Slide’ at toolbar.
IV.  Select the slide having Title slide and Bullet list. %
> Inserting Excel sheet: O
l. Open the slide where yiu want to insert the Excel sheet. Q\
Il.  Select the ‘insert tab’. And click on ‘Object’ on toolbar. q

Il. Select the ‘Microsoft Excel Worksheet’ object type.

V. Click the ‘OK’ button. &
» Clip Art and text: \

l. Selection the insert tab. Qr&

1. Select the ‘Pictures’ or ‘Online Pictures’ on too .
lll.  Choose the appropriate art for the topi(\
V. Click on the ‘insert’ button. \r'b

» Slide show effects:
l. Select ‘Design Tab’ for the %iants and slide size.

1. Select ‘Transition Tab’ =fade, push, wipe, split, Reveal, shape, Flash, etc. for slide

effects.
Q16. What is the diﬁerenc&&e language and High level Language?

Ans. Machine language High level language
1. A computer programming 1. Itis a programming language
language consisting of that enables development of a
binary instruction which a program much more user
N computer can respond to friendly programming context.
P directly. 2. It takes additional translation
V\ 2. It require no translator to time to translate the source
Q) translate the code. It is code to machine code.
() directly understood by the 3. The takes additional
computer. translation time to translate
3. This language makes fast the source code to machine
and efficient use of the code
computer. 4. They are programmer friendly.

Q17. Discuss about different data types of C programming Language.
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Ans. The different data types in C programming language are:

Char: The most basic data type in C. It store a single character and requires a single bite of
memory in almost all compilers.

Int: As the name suggests, an Int variable is used to store an integer.

Float: It is used to store decimal numbers,

Double: It is used to store decimal numbers (number with floating point value but of menﬂv@%
high in comparison to float) ®
Q18. Find the output of the following expressions. ®
a) X=20/5*2+30-5 b)Y=30-(40/10+6)+10 c)Z=40*2/10-2+10 ’b
Ans. a) X=33 %
b) Y=30 \Q
c) Z=16 Q
Q19. Describe the syntax of the following statement. %‘
a) If —else statement b) For loop c) White loop dQ\%e

Ans. a) If — else statement: 0

loop

If statements can be followed by an optiona\ lock of statements, which executes when the
Boot can expression is false.

Syntax ’\'
o)

If (expression) @
( o

True block of statementsQ§

) .(<Q
else Q'\'

{
eIs%lo:k statements;

() b) Forloop is similar to while loop. Basic syntax of loop is as follows:
For (expression 1; expression 2; expression 3)

{

Block of statement

}

In the above syntx
Expression 1- initialize variable
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Expression 2- conditional expression as long as this condition is true, loop will keep

executing.

Expression 3- itis the modifier which will increase or decrease the value of the variable.

c) While loop

Basic syntax of while loop is as follows

While (condition)
Single statements
OR while (condition)

{

Block of statements

}
d) Do- while loop.

Do- while loop is just like a while loop except that text condition is checked at
loop rather thn the start. This has the effect that the body of the loop are&

least once

Basic syntax of do- while loop is as follows.

Do
{

Single statements
OR
} while ( condition );

a £

Q20. Find the output of the following program segmﬁ&

Sk
nd of the
executed at

o

a)

b)

c)

@2

#include <stdio.h>
Int main()
{
Intl;
For (i=1;1<2;1++)
{

Printf(“IMS Ghaziabad\n”);

}

#include <stdio.h>
Int main()
{
Int 1=1;
While ( 1<=2)
{
Printf(“IMS Ghaziabad\n”);

}

#include <stdio.h>
Vold main()
{
Int a=10, b=100;
If (a>b)

Printf(“Largest number is
%\n”,a);

else

Printf(“Largest number is
%d\n”,b);

}

Ans.a) 1

C) b=100













NO NAME MARKS SUM | AVERAGE| MIXIMUM MINIMUM
1 nl 60 654 65.4 90 40
2 n2 70 594 66 90 40
3 n3 80 524 65.5 90 40
4 n4 90 444 63.42857 90 40
5 n5 40 354 59 88 40
6 n6 50 314 62.8 88 44
7 n7 77 264 66 88 44
8 n8 44 187 62.33333 88 44
9 n9 88 143 71.5 88 55

10 nl0 55 55 55 55 55

Q11




SUBJECT TERM1 TERM 2 TERM 3 TERM 4 FINAL
MATH 45 56 60 56 217
ENGLISH 50 83 54 70 257
HISTORY 60 50 50 60 220
GEOGRAPHY 80 70 20 90 260
BIOLOGY 50 60 40 50 200

AVERAGE 57 63.8 44.8 65.2 230.8
HEIGHEST 80 83 60 90 260
LOWEST 45 50 20 50 200

Q12




Q14. a) What tools are available to_customize our Poywer oint

presentation?



b) Write the steps for the following action for the creation of power poin}
presentation e e M

— Omlank presentation
Save the presentation as Labl.pptx
Add a Title to the first slide: the name of your collage
Type your first name and lat name in the Subtitle section
Add a New Slide which has a Title and Content
Ans.
To open blank presentation
Open PowerPoint presentation using ‘Run’ command (Window Key + R)
Select the ‘Blank Presentation’. It is opened.
Save the presentation on Labl.pptx.:
Select the ‘File’ on Tab bar.
Click on ‘Save As’ option.
Click on document/Desktop as your choice.
Type the name ‘Lab 1.pptx’.
Click the ‘Save’ button.



/
~ »>—Add a Title to the first slide; the name of your college.
Left click on the ‘Click to Add Title’ section on the first

slide.
Type the name of your college.

Type your first name and last name in the subtitle
section;

Left click on the ‘Click to Add Subtitle’ section.

Type your fist name and last name.

Add a New slide which has a title and content.

Selection the home tab.

Click on the dropdown button of the ‘New Slide ¢ on toolbar.
Selection the slide having ‘title and Content’. It 1s added.



Wteps for creation of a set of PowerPeint slides that dem
skill to use the tools of PowerPoint. It should include the following things.
-- Titles slide 7 bullet list
-- inserting Excel Sheet
-- Clip art an text
-- slide show effects

Ans.
Title slide and bullet list:
Open PowerPoint Presentation.
Select the home tab.
Click at the dropdown button on ‘New Slide’ at toolbar.
Select the slide having title slide and bullet list.
Inserting Excel sheet;
Open the slide where you want to insert the excel sheet.
Select the ‘insert tab’. And click on ‘Object’ on tool bar.
Select the ‘Microsoft Excel worksheet’ object type.
Click the ‘OK’ button.



\ /

—_—

——Clip Art and Text;
Select the insert Tab.

Select the ‘Pictures’ or ‘Online pictures’ on tool bar.
Choose the appropriate art for the topic.

Click on the ‘insert’ button,

Slide show effects;

‘Select ‘Design Tab’ for themes, Variants and Slide size.

Select ‘transition tab’ for Cut, push, Wipe, Split, Reveal,
Shape, Flash, etc. for slide effects.
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